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ABSTRAKT 

Táto práca je zameraná na overovanie výkonnostného potenciálu, ktorý v sebe ukrýva hra-

cia konzola XBOX. V práci sú podrobne popísané postupy úprav, po ktorých sa táto kon-

zola približuje klasickému domácemu PC. Ďalej je dokázané, že konzola XBOX dokáže 

pracovať ako kompletné multimediálne a zábavné centrum. Pomocou XBOXu je možné 

prehrávať filmy, hudbu, prehliadať fotografie, hrať hry, surfovať na internete, ba dokonca 

nahrádza aj domácu kanceláriu. V porovnaní s klasický domácim PC je táto konzola po 

patričných úpravách jeho potenciálnym náhradníkom. 

 

Kľúčové slova:  XBOX, ModChip, Aladdin Advanced, Gentoox, XDSL, hracia konzola   

 

 

 

ABSTRACT 

This work is aimed to verify the power potential, that the XBOX console is hiding. In the 

work  the procedure of the adjustements after wich the console is bringing closer to classi-

cal home PC is describer in detail. Next it is also demonstrated that the XBOX console is 

able to wortk as a full-featured multimedia and entertainment centre. It is able to play mo-

vies, music, view photos, play games, surf the web or even replace the home office. Compa-

red to classical home PC is this console after some adjustments the potentiall replacement.   

 

Keywords: XBOX, ModChip, Aladdin Advanced, Gentoox, XDSL, game station 



Úvodom si dovoľujem poďakovať vedúcemu diplomovej práce Ing. Tomášovi Sysalovi, 

Ph.D za odborné vedenie, poskytnuté rady, informácie a trpezlivosť. Ďalej poďakovanie 

patrí mojej mame za finančnú podporu pri tvorbe tejto práce, slečne Bc. Zuzane Zborovja-

novej za zapožičanie digitálneho fotoaparátu. 

 

 

 

 

 

 

 

 

 

 

 

Souhlasím s tím, že s výsledky mé práce může být naloženo podle uvážení vedoucího dip-

lomové práce a ředitele ústavu. V případě publikace budu uveden jako spoluautor. 

Prohlašuji, že jsem na celé diplomové práci pracoval samostatně a použitou literaturu jsem 

citoval. 

Ve Zlíně,  22. 05. 2006 .................................................  

 

 



OBSAH 

ÚVOD .............................................................................................................................. 7 

I TEORETICKÁ ČÁST ........................................................................................... 8 

1 HRACIE KONZOLY ............................................................................................ 9 

1.1 SONY PLAYSTATION 2.................................................................................... 12 

1.2 NINTENDO GAMECUBE ................................................................................ 13 

1.3 MICROSOFT  XBOX..................................................................................... 15 

1.4 MICROSOFT  XBOX 360 .............................................................................. 17 

2 ANALÝZA ZARIADENÍ..................................................................................... 20 

2.1 XBOX - PODROBNÝ POPIS ............................................................................... 20 
2.1.1 Hardware.................................................................................................. 20 
2.1.2 Software................................................................................................... 27 

2.2 PC - JEDNODUCHÝ POPIS.................................................................................. 30 
2.2.1 Hardware.................................................................................................. 30 
2.2.2 Software................................................................................................... 30 

II PRAKTICKÁ ČÁST............................................................................................ 31 

3 XBOX VS PC ....................................................................................................... 32 

3.1 ÚPRAVA XBOXU ............................................................................................ 32 
3.1.1 ModChip .................................................................................................. 32 

3.1.1.1Inštalácia ............................................................................................... 33 
3.1.2 Dashboard ................................................................................................ 36 

3.1.2.1 Inštalácia UnleashX .......................................................................... 39 
3.1.2.2 UnleashX - popis .............................................................................. 42 

3.1.3 XBMC...................................................................................................... 52 
3.1.4 XBOX Linux ............................................................................................ 58 

3.1.4.1 X-DSL Linux.................................................................................... 58 
3.1.4.2 Gentoox Linux.................................................................................. 62 

3.2 POROVNANIE ................................................................................................... 65 

ZÁVER .......................................................................................................................... 67 

ZOZNAM POUŽITEJ LITERATÚRY........................................................................ 69 

ZOZNAM POUŽITÝCH SYMBOLOV A SKRATIEK.............................................. 71 

ZOZNAM OBRÁZKOV............................................................................................... 72 

ZOZNAM TABULIEK ................................................................................................. 75 

ZOZNAM PRÍLOH ...................................................................................................... 76 



UTB ve Zlíně, Fakulta aplikované informatiky 7 

 

ÚVOD 

Používanie PC sa stalo našou každodennou súčasťou. Dnes si bez neho, podobne ako aj bez 

mobilného telefónu, nevieme predstaviť našu realizáciu. Zameriavam sa na skupinu ľudí, 

ktorí svoj PC používajú na bežné účely. To znamená, že väčšina ľudí používa svoje PC 

z väčšej časti na zábavu (hranie hier, počúvanie hudby, sledovanie filmov, surfovanie na 

internete) a z menšej časti aj na prácu (word, excel, powerpoint). Áno, práve za týmto úče-

lom si ľudia kupujú niekedy až príliš drahé počítačové zostavy. Cena tejto zostavy úmerne 

stúpa s výkonom PC. A tu sa nastoluje otázka. Načo potrebuje človek počítač s čo najlep-

ším výkonom? Moja odpoveď je: „Na hranie hier!“ Áno, práve toto je hlavný dôvod. Na 

sledovanie filmov, surfovanie po internete, počúvanie hudby alebo písanie dokumentov, 

človek vôbec nepotrebuje supervýkonný stroj. Teda, ako som už napísal, výkonný domáci 

počítač je hlavne na hranie hier. Čo takto použiť na hranie hier zariadenie, ktoré je na to 

určené. Toto zariadenie má názov XBOX. Veľa ľudí ani nevie, čo toto slovo znamená. Je to 

do značnej miery chyba spoločnosti MICROSOFT, ktorá dané zariadenie vyrába. Jej rekla-

mná kampaň bola smerovaná z veľkej časti do USA, kde sa toto zariadenie aj veľmi dobre 

predávalo. Ďalší problém je v tom, že na našom trhu bolo podobné zariadenie, ktoré malo tú 

správnu reklamu a aj svojich priaznivcov. Bol to PLAYSTATION 2 (ďalej len PS2) od fir-

my SONY. Šikovný a hlavne zvedavý ľudia zisťovali, kde sa skrýva výhoda XBOXu oproti 

PS2. Rozobrali XBOX a zistili, že je to vlastne zariadenie, ktoré je svojou vnútornou štruk-

túrou veľmi podobné klasickému PC. A nasledoval zdĺhavý proces pokusov, ako preniknúť 

hlbšie a dokázať, že nielen vnútornou architektúrou je XBOX podobný klasickému PC, ale 

aj funkčne. Ba dokonca veľa používateľov XBOXu tvrdí, že je ho možné použiť ako náhra-

du klasického PC. Pokúsim  sa dostať hlbšie do tejto problematiky a zistiť výhody a nevý-

hody tohto zariadenia. V nasledujúcich kapitolách popíšem jeden zo spôsobov, ako som 

upravil XBOX a čo všetko som pri tom zistil. Budem sa venovať nielen XBOXu, ale aj jeho 

konkurentom. Porovnám ich výkonnostné parametre a ich potenciál. Pokúsim sa nainštalo-

vať operačný systém Linux do XBOXu. Použijem niekoľko rozdielnych distribúcií a zistím, 

ktorá je najvhodnejšia. Táto práca môže slúžiť ako návod pre niekoho, kto by chcel podob-

ný proces realizovať na vlastnom XBOXe. Práca obsahuje značné množstvo fotodokumen-

tácie, ktorá umožňuje hlbšie preniknutie do danej problematiky.   
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I.  TEORETICKÁ ČÁST 
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1 HRACIE KONZOLY 

Herné konzoly sú špecializované počítače, skonštruované pre hranie hier a prevádzkovanie 

niektorých softwareov. Keďže nie sú také všestranné ako stolové počítače a ich výkon je 

odladený pre hry, ich cena je neraz prijateľnejšia, ako cena herného počítača. Daňou sú však 

obmedzené možnosti použitia a vyhranenie pre konkrétne herné platformy.[8] 

Konzoly prichádzajú na trh v dvoch vyhotoveniach - stolovom a vreckovom. Vreckové her-

né konzoly sú vybavené LCD displejom, prípadne dvoma, ktoré slúžia pre zobrazovanie 

priebehu hry. Rovnako majú zabudované reproduktory a výstup na slúchadlá. Stolové kon-

zoly sa pripájajú k televíznemu prijímaču (prípadne monitoru) a reproduktorovej súprave. 

Na každej hernej konzole je možné hrať iba tie hry, ktoré boli pre konkrétny typ vyvinuté 

alebo upravené. Nikdy nehrozí, ako pri počítači riziko, že výkon nebude dostatočný a hra 

nebude fungovať k plnej spokojnosti.[8] 

Výrobcovia herných konzol používajú rôzne ochrany na to, aby bolo možné hrať iba hry, 

ktoré sú legálne zakúpené. Bežná hra stojí od 500 korún po niekoľko tisíc, kópia hry bez 

špeciálnej úpravy konzoly nebude hrateľná. Výrobcovia zväčša po úprave neakceptujú zá-

ručné opravy.[8] 

K herným konzolám je dostupné rôzne príslušenstvo. Je možné zakúpiť vibračné a poloho-

vateľné herné ovládače, špeciálne ovládače pre letecké simulátory, zbrane, rôzne mikrofóny, 

kamery, švihadlá, herné dosky a iné exotické doplnky, ktoré podporujú interakciu.[8] 

Vrecková konzola je do istej miery závislá od stavu akumulátora (rovnako ako pri mobil-

nom telefóne).[8] 

Najpopulárnejšou stolovou konzolou je PS2. PS2 v základnej výbave, okrem hrania hier, 

umožňuje prehrávanie filmových DVD titulov, pričom si pre zvýšenie pohodlia možno do-

kúpiť dokonca i diaľkový ovládač. Konzola je následníkom predchodcu PS one a zvládne 

herné tituly určené pre seba i pre predchodcu. Zvukový výstup je analógový a stereofónny, 

pričom dostupný je aj digitálny šesťkanálový optický výstup, takže priestorový zvuk dodá 

hrám grády. Na Slovensku je oficiálne zastúpenie i podpora, takže je tu záruka, že všetky 

problémy sú riešiteľné. Okrem detí sa pobavia aj ich rodičia - príslušenstvo ako SingStar 

(pre karaoke), EyeToy (kamera) či rôzne tanečné podložky rozvíria skupinovú zábavu. Ce-
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ny hier sa pohybujú od 900 do 2600 korún, pričom bazáre s lacnými titulmi nie sú ničím 

nereálnym.[8] 

Pre vstup do sveta hier, je možné využiť staršiu PS one. Kúpiť sa dá za pár korún použitá, 

je pre ňu v obehu dostatok titulov pre nováčikov. Konzola navyše dokáže prehrávať videá 

vo formáte VCD a hudobné nosiče. Zaujímavým voliteľným príslušenstvom je prídavný 

LCD displej, takže sa dokážete zaobísť i bez televízora.[8] 

Druhou najpopulárnejšou stolovou konzolou je XBOX. Poskytuje o čosi vyšší výkon ako 

PS2 a tým dokáže ponúknuť pre hráča niektoré dokonalejšie tituly v plnom šesťkanálovom 

zvuku. Konkurenčná PS2 kompromisne obmedzuje v niektorých prípadoch zvuk na úkor 

grafiky na štandard Dolby Pro Logic II, aby používateľ nebol ukrátený o akciu a detaily. 

Ceny hier sú podobné ako pri PS2, niektoré tituly sú však drahšie. Drobným problémom je 

prepojenie priestorového zvuku. Stereofónny výstup je možné nahradiť digitálnym výstu-

pom za použitia špeciálneho kábla. XBOX umožňuje prehrávať DVD nosiče, samozrejme, 

iba za príplatok. DVD kit obsahuje senzor a diaľkový ovládač, ostatná podpora je už v kon-

zole. Výber hier zodpovedá vkusu Európanov, tituly sú veľmi blízke hráčom z PC platfor-

my. Na XBOX existuje množstvo úprav, ktoré ho umožnia premeniť na multimediálne cen-

trum domácnosti - dokáže zo siete prehrávať DivX filmy, MP3 skladby, z internetu sa dá 

pristupovať k meteorologickým dátam a podobne. Nedávno bola na trh uvedená nová verzia 

konzoly XBOX 360, ktorá je skutočným multimediálnym centrom domácností s pripojením 

na internet a podporou HDTV štandardu.[8] 

Ďalšou alternatívou je Nintendo GameCube . V našich končinách však ide skôr o raritu ako 

rozšírenú platformu. Konzola používa 8 cm DVD disky pričom herné tituly sú zamerané 

hlavne na mladšiu vekovú kategóriu. Na prehrávanie DVD titulov však môžete zabud-

núť.[8] 

Stolové konzoly s výnimkou GameCube umožňujú hrať hry i cez internet. V prípade PS2 je 

služba Central Station zadarmo. Je možné hrať proti spoluhráčovi zo susedného vchodu 

alebo i druhého konca sveta. V prípade služby XBOX Live ide o platenú službu.[8] 

Herná konzola Nintendo DS je vybavená dvojicou displejov, dotykovým rozhraním a bez-

drôtovým WiFi rozhraním. Herné tituly sú distribuované na pamäťových médiách s kapaci-

tou 128 megabajtov a do úlohy vstupuje aj interakcia s okolím. Konzola je kompatibilná s 
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jej jednoduchšími predchodcami GameBoy Advance. Hry sú skôr orientované na ázijský trh, 

ponuka kvalitných titulov však existuje. K dispozícii je i režim multiplayer, kde môžu viacerí 

hráči hrať spoločne alebo proti sebe prostredníctvom WiFI spojenia a služby DS Downlo-

ad.[8] 

Spoločnosť Sony má v obehu vreckovú konzolu PSP. Teší sa širokej popularite vďaka širo-

kým možnostiam použitia, ktoré nie sú obmedzené výhradne na hranie hier a pomerne veľ-

kému displeju, osadeného do precízne vypracovaného tela. Mobilné multimediálne centrum 

si poradí so skladbami vo formátoch MP3 alebo ATRAC, umožňuje prezeranie digitálnych 

fotografií, a nechýba ani podpora pre video vo formáte MPEG4. Na internete sa nachádza 

mnoho rôznych projektov, medzi ktorými nechýba webový server, rôzne prehliadače a po-

dobne. Výhodou je zabudované WiFi rozhranie. Herné tituly sú distribuované na diskoch 

UMD s kapacitou 1,8 gigabajtu, pamäťovým úložiskom sú karty formátu Memory Stick 

PRO Duo. Hráči si na tejto konzole pochvaľujú kvalitný displej a analógový ovládač 

hier.[8] 

Kombináciou mobilného telefónu a vreckovej konzoly vznikol projekt Nokia N-gage. Novší 

model (avšak ochudobnený o FM tuner a MP3 prehrávač) N-gage QD je dostupný na pul-

toch predajní. Vrecková konzola ponúka výkon pre 3D, hry dodávané na MMC kartách, 

ktoré sa dajú za chodu meniť. Nechýba podpora IM komunikácie, možnosť práce s elektro-

nickou poštou, či prehliadač wapových stránok. S okolitým svetom sa okrem GSM/GPRS 

siete spojíte i bezdrôtovým Bluetooth rozhraním.[8] 

Na niektoré herné konzoly sú dostupné i emulátory. Umožňujú hrať hry určené pre iné plat-

formy alebo oživiť staré herné tituly z éry 8-bitových počítačov. Zaujímavosťou je i stolový 

prehrávač Orava DVD 505, ktorý obsahuje zabudovaný emulátor pre staré 8-bitové tituly a 

dvojicu herných ovládačov.[8] 

Koľko zaplatíte za konzolu? 

• PS One  1500 Sk za použitý model 

• PlayStation2  6200 Sk 

• XBOX  7500 Sk 

• XBOX360  16900 Sk  
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• Nintendo GameCube  3900 Sk 

• PSP  9800 Sk 

• Nintendo DS  5200 Sk 

• Nokia N-gage QD  6500 Sk 

• Nokia N-gage  6000 Sk 

1.1 SONY PlayStation 2 

 

Obr. 1. Sony PlayStation 2. 

PS2 je po krachu SEGA DreamCastu najstaršou spomedzi troch aktívnych herných zariade-

ní. Na trhu je k dispozícií už nejaký ten rok, čomu zodpovedajú aj jej kedysi revolučné pa-

rametre. PS2 využíva vlastný procesor Sony Emotion Engine taktovaný na 295 MHz a gra-

fickú kartu Sony Graphics Synthesizer na 150 MHz, pričom konzola podáva hrubý výkon 

75 milionov polygónov za sekondu. 32 MB pamäť je na mnohé dnešné hry už pravdupove-

diac málo. Hry vyzerajú zo všetkých troch kandidátov jednoznačne najkostrbatejšie, ba do-

konca tituly (Wipeout Fusion, NHL 2001) dokonca aj sem tam sekali. Pri zaostávajúcom 

grafickom výkone však exceluje 48 kanálový stereo zvuk a multimediálne funkcie PS2 ako 

je prehrávanie AUDIO CD a AUDIO DVD. Dôležitým faktorom je aj zážitok z hry a prí-

jemné ovládanie. 10 tlačídlový ovládač DualShock 2 má výbornú ergonómiu, padne do ruky 

a jednoducho sa s ním ovláda. Naviac PS2 je využiteľný aj ako prehrávač CD/DVD Video 

bez nutnosti čokoľvek dokupovať, ako je tomu u X-Boxu.[9] 
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DOPLNKY 

Mimo spomenutého základného súboru existujú k PS2 aj rôzne prídavné zariadenia, ktoré je 

možné dokúpiť. Neoplatí sa hrať hry bez 8MB pamäťových kariet, na ktoré je možné uložiť 

pozície v hre. Na druhej strane, jedna pamäťová karta vystačí na veľké množstvo hier. Po-

tom sú to rôzne doplňujúce ovládače, rozšírenie na 4 ovládače a volanty, ale najväčšiu po-

zornosť lákajú posledne vypustený modem na pripojenie na internet a 40 GB prídavný 

HDD.[9] 

 

PRE & PROTI 

Napriek najstaršej technológii je PS2 jedničkou z 3 kandidátov. Po svete sa predalo vyše 30 

miliónov kusov PS2, čím sa stáva najlukratívnejšou platformou s pohľadu vývojárov hier. Z 

pohľadu hráčov je to zasa najširšia ponuka rôznych titulov, pričom si Sony podchytili väčši-

nu kvalitných titulov pre exkluzivitu jedine na ich konzoly. Naviac je PS2 kompatibilná so 

staršou konzolou PS1, takže na rozdiel od iných konzol je možné hrať staré hry so starou 

pamäťovou kartou a ovládačom.[9] 

1.2 NINTENDO GameCube 

 

Obr. 2. Nintendo GameCube. 

Nintendo vypustilo svoju novú konzolu štvrtej generácie súčasne s XBOXom a za krátku 

dobu si s počtom 12 miliónov predaných kusov vybojovalo druhú pozíciu na trhu. Nintendo 

prichádzalo so svojimi konzolami mimo prvej konzoly NES vždy s oneskorením, čo muselo 

doháňať kvalitnou ponukou hier. Konzolu GameCube dlhšiu dobu označovali pod tajom-
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ným názvom Dolphin a do vojny konzol novej generácie sa s Nintendom počítalo skôr ako s 

outsiderom, realita však prekvapila o opaku. Marketing Nintenda sa na rozdiel od ostatných 

dvoch spoluhráčov vždy orientoval a orientuje hlavne na mladších hráčov do 15 rokov a v 

tomto smere ani pri novej konzole nespravili žiadnu výnimku. Tituly na Nintendo spadali 

vždy pod prísnu cenzúru, čo sa krvi a násilia týka. A aj preto bol maskotom Nintenda vždy 

mierumilovný inštalatér Mário. K tomuto zameraniu sa tentoraz uspôsobil aj design „krabi-

ce“ konzoly. Konzola má najmenšie rozmery spomedzi všetkých kandidátov, je najľahšia a 

ľahko prenášateľná. Svojím výzorom pôsobí zlatučkým dojmom, ako pekná hračka pre deti. 

Pod kapotou GC však drieme procesor 485 Mhz IBM "Gekko" PowerPC a grafická karta 

162 MHz ATI "Flipper" plus 40 MB pamäť. Jeho čistý výkon je približne 12 miliónov poly-

gónov za sekundu. Nintendo tentoraz na rozdiel od Sony podobne ako Microsoft využila 

partnerskú spoluprácu so špecializovanými spoločnosťami IBM a ATI a ťah sa im vydaril. 

Čo sa týka médií, Nintendo sa opäť rozhodlo zvoliť iné médium, našťastie tentoraz už defi-

nitívne opustili nešťastné cardtridge a zvolili zmenšené 8cm DVD disky s kapacitou 1.5 GB. 

Tým znížili náklady a cenu predávaných hier a svojou odlišnosťou aj možnosti pirátskych 

skupín. To však znamená, že na GC sa nedá spustiť žiadne DVD video ani hudba, ide len o 

hernú konzolu. Čo je iste škoda pri 64 kanálovom stereo zvuku. 

Ovládač k GC je porovnateľný s Duashockom k PS2 po všetkých hľadiskách a nemožno ho 

inak než odporučiť, navyše má konzola podobne ako XBOX zabudované 4 USB porty na 

ovládače a netreba dokupovať doplňujúce zariadenie.[9] 

 

DOPLNKY 

Pri hraní sú potrebné pamäťové karty, ktoré sú malé oproti PS2 kartám, ale kapacitou ne-

zaostávajú. K GC by sa mal predávať 56K Broadband a Narrowband modem a tiež prídavný 

harddisk na sťahovanie súborov z internetu. Inou záležitosťou je trójský kôň Nintenda, spo-

jením ich bezkonkurenčného handheldu GameBoy Advance s GameCube. GameBoy je 

možné ku GC pripojiť ako ďalší ovládač, ale dá sa aj stiahnuť do GameBoya časť hry a hrať 

ju potom mimo konzoly samostatne a následne pokračovať pri pripojení na konzolu.[9] 

 

PRE & PROTI  
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GC je najvhodnejšie pre deti. Je tu minimálne riziko poškodenia ich vývoja. Naviac je ľahko 

transportovateľný a prepojiteľný s GameBoy Advance. Dodáva sa v dvoch farebných ver-

ziach (Fialová a Čierna).[9] 

1.3 MICROSOFT  XBOX 

 

Obr. 3. Microsoft XBOX. 

Microsoft je v oblasti hier na konzoly v porovnaní s ostatnými kolegami pomerne mladým 

súperom. Napriek tomu sa od ich konzoly XBOX predpokladal raketový nástup hlavne 

vďaka najvýkonnejším technológiám a širokej marketingovej podpore. Neoficiálne sa do-

konca povráva, že SEGA DreamCast bol XBOX 0, kvôli faktu, že DreamCast sa po roku 

napriek veľkému úspechu konzoly vo svete ju SEGA z nevysvetliteľných príčin stiahla z 

obehu a prestala podporovať. Nech už bola realita okolo DreamCastu akákoľvek, čierna 

krabica s písmenom X na vrchu v sebe skrýva Intel Pentium III, 733 MHz a grafickú kartu 

250 MHz NVidia "XGPU" plus 64 MB pamäť. Pri tejto konštalácií dokáže XBOX vytlačiť 

neuveriteľných 125 miliónov polygónov za sekundu, čím nekompromisne kraľuje v oblasti 

výkonnosti nad svojimi súpermi. Tento výkonnostný rozdiel je aj poznať, pre porovnanie 

rovnaké tituly z PS2 Onimusha a NHL sú detailnejšie, a rýchlejšie. Jednak je to podporou 

vyššieho rozlíšenia a potom vyšším počtom polygónov zobrazených na scéne. Ďalším revo-

lučným prvkom v XBOXe je zabudovaný 8 GB harddisk, na ktorý sa dajú ukladať hry, sú-

bory z internetu a hudobné CD. Svojou kapacitou by mal na vymenované úkony disk plne 

postačovať, pretože mimo spomenutých možností sa na neho neinštalujú žiadne časti hier. 

Takže na obdivuhodnej rýchlosti má podiel jedine väčšia pamäť a rýchly procesor, ktoré 



UTB ve Zlíně, Fakulta aplikované informatiky 16 

 

spracúvajú snímané CD/DVD médium s programom. XBOX je ďalej podobne ako GC vy-

bavený 4 USB portami na ovládače. Bohužiaľ ovládač XBOXu je kameňom úrazu sám o 

sebe. V prvom rade je neznesiteľne veľký, nepadne do rúk, ktoré následne bolia z tlačítok, 

pretože nie sú ergonomicky rozmiestnené. Mnohokrát treba pozrieť na ovládač, kde je pot-

rebný gombík. Takmer identický ovládač mala SEGA DreamCast, no z jej problémov sa 

Microsoft nepoučil, pridal navyše jeden joystick a nevkusne rozmiestnil tlačidlá. Z multime-

diálnych funkcií v základnom súbore je mimo internetu jednoznačne najzaujímavejšia mož-

nosť ukladať si hudobné CD na harddisk a prehrávať ich cez 256 audio kanálov, čim si mô-

žete XBOX z hernej konzoly zmeniť na J-Box (jukebox). Tým sa však multimediálne do-

plnky XBOXu končia. V konzole je síce zabudovaný CD/DVD Video prehrávač, ale na 

jeho aktivovanie a ovládanie je potrebné dokúpiť špeciálny XBOX ovládač.[9] 

 

DOPLNKY 

Medzi doplnky, podobne ako u ostatných konzol, patria ďalšie ovládače, volanty a pamäťo-

vé karty, a ako som už spomenul, ovládač na DVD. Napriek vstavanému harddisku je mož-

né zakúpiť pamäťovú kartu a uložené pozície tak preniesť na iný XBOX.[9] 

 

PRE & PROTI 

Medzi hlavné silné stránky XBOXu patrí jeho výkonnostný náskok oproti ostatným konku-

rentom, zabudovaný harddisk a pripojenie na internet cez ethernet, v podstate si netreba nič 

dokupovať mimo ďalších ovládačov a ovládania na Video. Nepriaznivo však pôsobí ne-

vkusný ovládač. Taktiež design XBOXu je krokom vedľa. Krabica je príliš veľká, rozmermi 

pripomína PC a je neuveriteľné ťažká, teda absolútne nevhodná na prenášanie.[9] 
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1.4 MICROSOFT  XBOX 360 

 

Obr. 4. Microsoft XBOX 360. 

XBOX 360 je prvá z konzol ďalšej generácie. Konzola ponúka niekoľko násobne vyšší vý-

kon ako jej predchodca a momentálna konkurencia, množstvo nových funkcií, výrazne roz-

šírenie online možností a hlavne hi-res obraz pre HDTV. Microsoft konzolu predáva v 

dvoch baleniach - Core edition za 299 euro a Premium edition za 399 euro. Core edition 

je síce lacnejší, ale aj obmedzenejší a hlavne absenciou HDD stráca sériu možností, ktoré 

poskytuje Premium edition. HDD totiž konzolu stavia prakticky na PC herný štýl a umožní 

sťahovať do konzoly videá, demá, krátke plné hry, hudbu a zaisťuje aj spätnú kompatibilitu 

hier so starým XBOXom. Bez HDD však je stále možné prepojiť konzolu s rôznymi zaria-

deniami cez USB a pozerať z nich obrázky, prehrávať hudbu a aj prepojiť s PC, kde sa dá 

okrem obrázkov a hudby prehrávať aj video, prijímať a nahrávať digitálny signál cez Media 

Center PC. Premium edition je lepší aj v ponuke periférií, kde v balení obsahuje wireless 

ovládač, headset, diaľkové media ovládanie (len v obmedzenej úvodnej edícii konzoly) a má 

kvalitnejšie AV káble. Obe edície majú v sebe "tehlový" zdroj zaisťujúci napájanie pre kon-

zolu. Po hardwarovej stránke XBOX 360  v sebe skrýva  3x dual core 3.2GHz procesory 

(teda spolu 6 jadier nataktovaných na 3.2 GHz), ATI 500MHz grafický čip s 10MB 

EDRAM (podobná karta do PC je x1900 XTX za 500 dolárov), a sharovaných 512MB 

RAM medzi grafikou a systémom. K tomuto výkonnému delu je jediné obmedzenie a to 

klasická DVD ROM mechanika, ktorá nie je next-genová, ale na hry by mala na najbližších 

pár rokov stačiť. HDD je momentálne k dispozícii o veľkosti 20GB. Prvé dojmy z konzoly 
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boli dobré, kvalitné plasty, slušný design a príjemná kompaktná veľkosť, ktorá je síce len o 

pár centimetrov menšia ako pôvodný XBOX, ale vďaka designu pôsobí menej zavalito. 

Rovnako príjemný design má aj ovládač a aj média ovládanie. Jediným rušivým prvkom 

designu je zdroj, ktorý je síce možné schovať za televízor, ale aj tak mohol byť aspoň desig-

novo prispôsobený. Mimochodom, základná farba XBOXu je zatiaľ len biela, ktorá sa ne-

musí hodiť každému. Dá sa síce skinovať, ale nahradiť môžete jedine predný kryt (facepla-

te). Dajú sa kúpiť kryty v rôznych prevedeniach - strieborné,  tatoo štýly, červené, zelené, 

modré, dúhové, alebo tématické (ktoré už sú zväzované aj s predobjednávkami hier). Z 

periférií je ovládač veľmi dobre navrhnutý a najviac sa podobá na wireless Logitech ovládač 

zo starého XBOXu, ale cítiť, že je ešte prepracovanejší a lepšie sa drží. Pri XBOXe 360 si 

bude treba zvykať  na trigger buttony, ktoré na ovládači pribudli presunutím bieleho a čier-

neho tlačidla dozadu. Má to tú výhodu, že sa už začnú v hrách masívnejšie využívať. Plus 

novému ovládaču pribudlo aj guide tlačidlo, ktorým sa zapína ovládač, zapína-vypína kon-

zola, alebo sa vchádza do výsuvného menu s profilom kedykoľvek počas hry. Výhodou, ale 

aj nevýhodou wireless ovládača je, že ho treba vždy zapínať, čím sa inicializuje a pripojí na 

jeden wireless port konzoly (na konzole a aj ovládači sa zobrazí svetielko, na ktorý port je 

pripojená). Po vypnutí konzoly sa ovládač sám vypne. Napríklad, na starom logitech wire-

lesse stačilo po hre nechať opretý jeden trigger o stôl a ovládač stále vysielal, až kým sa 

baterky nevyšťavili. Káblový ovládač sa samozrejme inicializuje sám. Konzola ponúka aj 

prehrávanie videí, a hudby, kde zvukové súbory majú pekný media player aj s vizualizérom, 

videá však ponúkajú len jednoduchý prehrávač so základnými funkciami, rovnako aj pre 

prehrávanie DVD sú funkcie len základné. Oveľa väčšie rozšírenie má konzola pri prepojení 

na Media Center PC, ktorý vám z TV spraví Media Center TV so všetkými možnosťami. 

Videá sa však dajú prehrávať len vo WMV formáte, žiadne DivX, takže zatiaľ si bude treba 

počkať na nejakú utilitu, alebo divx prehrávač, ktorý to na konzole umožní.[10] 

 

DOPLNKY 

Z ďalších periférií k Xboxu je možné kúpiť ešte dobíjateľné baterky (do wireless ovládača), 

k tomu Play and Charge káble na priame nabíjanie batérií v ovládači a spomínaný VGA ká-

bel. Pre bezdrátové pripojenie na internet slúži wireless net adapter. Z periférií čoskoro vy-

jde XBOX 360 kamera, s ktorou pribudne aj videochat a pravdepodobne uvidíme aj minik-
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lávesnicu od Microsoftu. Nakoniec už bola ohlásená aj externá HD-DVD mechanika pre 

pozeranie filmov v HD kvalite.[10] 

 

PRE & PROTI 

Celkovo hodnotím konzolu veľmi pozitívne a treba povedať, že posunula konzolový svet na 

novú úroveň. Ako výkonom, grafikou, tak aj pridaním profilov a celým online prepojením, 

ktoré je jednoznačne budúcnosťou hier. Konzola má aj mínusy, hlavne v našej lokalite si 

Microsoft pripíše mínus, ani nie tak za nepodporovanie Slovenska v otázke predaja, ale za 

to, že pri vytváraní profilu ani Slovensko nie je možné vybrať a treba voliť či už Rakúsko, 

Anglicko, alebo inú podporovanú krajinu. [10] 
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2 ANALÝZA ZARIADENÍ  

2.1 XBOX - podrobný popis 

2.1.1 Hardware 

XBOX bol kompletne rozobraný a pokúsim sa opísať postup, akým bolo postupované. 

XBOX sa skladá z plastového krytu, ktorý je vystužený tenkým plechom. Plastový kryt je 

rozdelený na dve časti. Obidve časti sú spojené pomocou 6 skrutiek, ktoré sa nachádzajú 

pod podložkami a pod etiketami.  

 

Obr. 5. XBOX odstránenie skrutiek. 

Po odskrutkovaní týchto skrutiek treba odstrániť vrchný plastový kryt. Vo vnútri je 

DVDROM a HDD. MICROSOFT dával 3 druhy DVDROMov (Thomson, Philips, Sam-

sung). Najkvalitnejšia je Samsung, číta všetko a naopak najslabšia je Thomson. Mne sa 

samozrejme ušla Thomson a to má za následok, že číta iba kvalitné DVD médiá a lisované 

CD. HDD je v prvých verziách 8GB. V ďalších verziách je už 10GB, ale je zablokovaný na 

8GB. DVDROM aj HDD sú prepojené cez klasický IDE kábel. Postupne treba odpojiť IDE 

kábel z CDROMu, HDD a aj ich napájanie. DVDROM aj HDD držia ešte na plastových 

moduloch, ktoré sú pripevnené troma skrutkami.  



UTB ve Zlíně, Fakulta aplikované informatiky 21 

 

Tab. 1. Druhy DVD mechaník 

 

Obr. 6. DVD Thomson. 

 

Obr. 7. DVD Philips. 

 

Obr. 8. DVD Samsung. 

 

 

Obr. 9. XBOX bez vrchného krytu. 
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Po odstránení modulov sa uvoľní prístup k základnej doske. Táto doska je upevnená pomo-

cou 11 skrutiek. Je potreba odpojiť napájanie dosky a napájanie ventilátora. 

 

Obr. 10. Odstránenie jedenástich skrutiek. 

Jednotlivé verzie XBOXu sa odlišujú štruktúrou svojej základnej dosky. Nikto nevie pri 

kúpe, aká je to verzia. Najpresnejšia metóda ako to zistiť, je rozobrať XBOX. Je viacero 

poznávacích znakov. Verzia 1.0 mal ventilátor aj na chladiči grafického chipu. Ostatné ver-

zie už nie. 
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Obr. 11. XBOX 1.0 s ventilátorom. 

Ďalší znak odlišnosti je v konektore napájania. Verzie 1.0 a 1.1 majú rozdielny konektor 

ako ostatné verzie.  

Tab. 2. Rozdiely v konektore napájania. 

 

Obr. 12. Konektor napájania vo 

vrzií 1.0 a 1.1. 

 

Obr. 13. Konektor napájania vo 

vrzií 1.2 až 1.6. 
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Hlavným poznávacím znakom je však AV-Chip.  

 

Obr. 14. AV-Chip. 

  

Tab. 3. Rozdiel v AV-Chipe 

 

Obr. 15. Verzia 1.2 a 1.3 ma-

jú "Conexant" chip. 

 

Obr. 16. Verzia 1.4 a 1.5 

majú "Focus" chip. 

Obr. 17. Verzia 1.6 má "Ex-

calibur" chip. 
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Pod najväčším chladičom sa skrýva procesor INTEL PENTIUM III s taktom 733MHz.  

 

Obr. 18 Procesor 733 MHz 

V spodnej časti obrázka sa nachádza výstup na zobrazovacie zariadenie a vedľa neho je 

ETHERNETOVÉ rozhranie RJ45. 

 

Obr. 19. Základná doska XBOXU 
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Ovládanie XBOXu je zabezpečené pomocou páčkového ovládača, ktorý slúži aj na hranie 

hier. Obsahuje dve analógové páčky, jeden ovládací kríž, dva tlakové ovládače a 8 tlačidiel. 

 

Obr. 20. Ovládač. 

Doplnkovým zariadením, ktoré potrebujeme na prehrávanie DVD filmov je DVD KIT. Ob-

sahuje diaľkový ovládač a infra snímač, ktorý sa pripája do slotu na pamäťovú kartu priamo 

na ovládači. 

 

Obr. 21. DVD KIT. 
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2.1.2 Software 

Po zapnutí XBOXu sa na obrazovke objaví celkom slušne vyzerajúce menu, ktoré je akýmsi 

prostriedkom pre jeho ovládanie a dalo by sa nazvať aj systémom. Tento systém firma 

MICROSOFT nazvala MS Dashboard. Popíšem jednotlivé funkcie tohto dashboardu.  

Úvodná obrazovka obsahuje 4 voľby. 

 

Obr. 22. MS Dashboard. 

MEMORY - Umožňuje správu hardisku a pamäťových kariet.  

 

Obr. 23. MS Memory. 
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MUSIC - Ďalšie využitie pevného disku. Vzhľadom k tomu, že XBOX prehráva aj hudobné 

CD, je možné vytvoriť vlastné hudobné výbery, ktoré sa ukladajú na pevný disk v 128kbit, 

16 bitovej stereo kvalite. Vytvorené hudobné výbery je možné prehrávať aj počas hrania 

hier. 

 

Obr. 24. MS Music. 

SETTINGS - Pod touto položkou sa nachádzajú všetky potrebné nastavenia. (dátum a čas, 

jazyk, audio, nastavenie siete, video, automatické vypnutie a systémové informácie) 

 

Obr. 25. MS Settings. 
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XBOX LIVE – slúži na pripojenie hráča do celosvetovej hernej siete. Bohužiaľ táto služba 

je platená. 

 

Obr. 26. MS XBOX Live. 
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2.2 PC - jednoduchý popis 

V dnešnej dobe väčšina z nás vie, ako taký počítač vyzerá. Práca je zameraná hlavne na 

hracie konzoly konkrétne XBOX, ale pre porovnanie aspoň stručný opis hardwarových častí 

PC. 

2.2.1 Hardware 

Každé PC ma vlastný case, ktorý skrýva použité komponenty. Základom je základná doska. 

Od nej sa potom odvodzuje ďalšie rozširovanie PC zostavy. Samozrejme sa od výkonnosti 

dosky odvíja aj jej cena. Ďalším prvkom je procesor. Je to vlastne srdce celého PC. Ďalej 

nasledujú pamäte. Pri pamätiach je dobré držať sa hesla nikdy nie je dosť. Predpokladom 

kvalitného zážitku pri hraní hier, je výkonná grafická karta. Táto karta sa zasúva ako karta 

do zbernice. Tu nám určuje základná doska, koľko kariet je možné pripojiť. Na doske býva 

vstavaná sieťová, zvuková karta a aj grafická karta (nevhodná na hry z hľadiska jej malého 

výkonu). Pre ukladanie dát, je treba pripojiť HDD. FDD mechaniky sú už dávno minulosťou 

a nahradili ich CD/DVD RW mechaniky. Bohužiaľ PC nie je možné pripojiť štandartne na 

televízor ako XBOX, preto treba použiť CRT alebo LCD monitor, ktorý však na rozdiel od 

klasického televízora ponúka omnoho detailnejšie a kvalitnejšie zobrazenie. Pre komuniká-

ciu s PC sa používa klávesnica a myš. 

2.2.2 Software 

PC ako také, by bolo úplne na nič, pokiaľ by na ňom nebol nainštalovaný operačný systém. 

Ten poskytuje komunikáciu s PC a zabezpečuje chod programov, potrebných pre vykoná-

vanie jednotlivých operácií s PC. 
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II. PRAKTICKÁ ČÁST 
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3 XBOX VS PC 

Na predchádzajúcich stranách bolo podrobne opísané zloženie hracej konzoly XBOX a aj 

jeho softwarové vybavenie. Zatiaľ bol XBOX opísaný v jeho „sériovej“ podobe. Tu sa ani 

nejako moc porovnávať tieto dve zariadenia nedajú. V tejto podobe XBOX slúži čisto ako 

hracia konzola s možnosťou prehrávania hudobného CD, alebo po zakúpení patričného 

ovládača aj ako DVD prehrávač. Nasledujúce strany sú venované úpravám, ktoré treba 

spraviť, aby bolo možné tieto dve zariadenia poriadne porovnať. 

3.1 Úprava XBOXu 

3.1.1 ModChip 

Ako prvé, je treba implementovať modifikovaný chip do XBOXu. Tento chip sa nazýva 

MODCHIP. Slúži ako náhrada klasického biosu. Kompletne vyradí a nahradí klasický, sé-

riový bios. Táto úprava si vyžaduje miernu zručnosť v letovaní a hlavne kvalitné zariadenie 

na letovanie. Po zavedení chipu sa XBOX správa úplne normálne len s tým rozdielom, že 

dokáže spustiť aj hry, ktoré sú napálené.  

Pri výbere modchipu treba zvážiť svoje schopnosti a podľa toho sa rozhodnúť, či si chip 

nainštalujete sami alebo si ho necháte nainštalovať. Modchip je charakterizovaný dvoma 

základnými prvkami: prevedením a inštalovaným biosom.[11] 

Prevedenie 

Chipy sa rozdeľujú do tzv. generácií. Prvá generácia je najnáročnejšia na inštaláciu, pripája 

sa 29 vodičmi, ktoré je nutné naletovať zo spodnej strany základnej dosky XBOXu. Výho-

dou však je, že tento chip je možné vytvoriť doma, za pomoci vhodného programátora pa-

mäti. Druhá generácia sa pripája už len 11 vodičmi. Tretiu generáciu tvorí tzv. LPC (low 

part count) modchipy to buď v neupdatovateľnej (non-flashable - generácia 3a) alebo upda-

tovateľnej (flashable - generácia 3b). Updatovateľnosť chipov znamená možnosť nahrania 

novšej verzie biosu. Chipy 3 generácie sa pripájajú jednoduchšie malým množstvom vodičov 

tzn. 9 a menej, ba dokonca existujú aj také chipy, ktoré netreba vôbec letovať. V prílohe PI 

sa nachádza porovnanie niekoľkých druhov. Ja som si vyberal podľa ceny. Chip Aladdin 

Advanced je najrozšírenejší chip na Slovensku a samozrejme najlacnejší. Jeho cena je 

595Sk.[11] 
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Obr. 27. Aladdin Advanced. 

3.1.1.1 Inštalácia 

XBOX bolo treba rozobrať. Na základnej doske nájsť miesto (označené červeným štvorcom 

na Obr. 28), kam bolo treba chip priletovať. 

 

Obr. 28. Miesto pre umiestnenie chipu 
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Chip má plôšky, ktoré treba priletovať na patričné miesto. 

 

Obr. 29. Naletovaný chip. 

Nasledovalo pripájkovanie 4 vodičov. Vodič L2 vedie na druhú stranu dosky a pripája sa na 

IDE rozhranie. Všade sa uvádza, že musí byť prepojený na prvý pin. Ja som skúsil iný 

a funguje bez problémov. 

 

Obr. 30. Pripojenie vodiča na IDE rozhranie. 
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Vodič L1 vedie na odpor R3G5 na jeho pravú stranu a vodič BT zas na odpor R3G3 na 

jeho ľavú stranu. 

 

Obr. 31. Pripojenie vodičov k odporom R3G3 a R3G5 

Ako posledný bol vodič DO, ktorý má svoje miesto v strednej z trojice dier. 

 

Obr. 32. Miesto pre pripojenie DO vodiča. 
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Obr. 33. Pripojený DO vodič. 

Takto nainštalovaný chip je pripravený na použitie. 

3.1.2 Dashboard 

Dashboard je v podstate operačný systém XBOXu. Je to program, ktorý sa spustí ako prvý 

po štarte. Originálny MS Dashboard som už popísal, teraz by som sa chcel venovať modifi-

kovanému dashboardu. Dashboard je zvyčajne uložený na pevnom disku, ale modchip u-

možňuje nabootovanie dashboardu i z mechaniky. DVD Originálny dashboard neponúka 

veľa možností. Naopak modifikovaný dashboard obrovsky rozširuje možnosti XBOXu. 

Takto modifikovaný dashboard zvláda prezeranie adresárovej štruktúry na HDD, umožňuje 

FTP spojenie s počítačom prostredníctvom sieťovej karty, ktorá je na doske, slúži na spúš-

ťanie programov, zabezpečuje kontrolu nad teplotou a veľkosťou volného miesta na HDD. 

Na výber je hneď niekoľko druhou dashboardov. 
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Obr. 34. Avalaunch. 

 

Obr. 35. EvolutionX. 
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Obr. 36. MXM. 

 

 

Obr. 37. UnleashX. 

V tomto prípade bol testovaný  UnleashX. 
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3.1.2.1 Inštalácia UnleashX 

Pri inštalácií boli potrebné nasledovné komponenty: 

- Jedno čisté CDRW, DVDRW, DVD-R médium, ktoré XBOX zaručene prečíta 

- UnleashX, ktorého základ tvoria dva súbory (default.xbe, config.xml), doporučujem 

verziu 0.37 a novšiu 

- Program Xiso na vytvorenie Xbootovacích ISO súborov 

- Akýkoľvek FTP klient pre PC (Total Commander) 

- Počítač so sieťovou kartou, CD/DVD vypaľovačkou a vypaľovacím softwarom (Ne-

ro) 

- Krížený UTP kábel pre prepojenie XBOXu a PC (je možné prepojenie aj pomocou 

HUBU) 

 

1. Súbory default.xbe a config.xml bolo treba na PC uložiť do adresára UnleashX 

2. Na editáciu súboru config.xml bol použitý notepad. 

<Network Enable="Yes" Type="Static"> - povoľuje sieť a definuje že IP adresa bude 

statická 

<IP>192.168.1.1</IP> - natvrdo zadaná ip adresu Xboxu. Adresa PC nesmie byť 

rovnaká ja som použil 192.168.1.2         

<Subnet>255.255.255.0</Subnet> - definuje masku podsiete (vychádza z IP adresy)  

<FTP Enable="Yes">  - povolenie FTP pripojenia a nasledovné nastavenie užívateľ-

ského mena a hesla              

<User>xbox</User> 

<Password>xbox</Password> 

Takto upravený súbor treba uložiť. 

3. Na vytvorenie xISO súboru bol použitý program Xiso a voľba TOOLS/Make xISO 

- výber adresára v ktorom sú uložené súbory default.xbe a config.xml 

- výber názvu cieľového súboru 

- v menu Tools -> Establish Shell Extension 
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4. Vypálenie CDRW 

- program NERO a voľba vypálenie obrazu disku 

- výber ISO súboru 

- záložka Write voľba Finalize CD, rýchlosť doporučujem nastaviť čo najmenšiu 

a voľba Writing method ->Track at Once 

5. Bootovanie dashboardu 

- vypálené CDRW bolo vložené doDVDROM mechaniky XBOXu 

- XBOX nabootoval nový dashboard 

6. HDD 

Pre dostatočné pochopenie štruktúry XBOXu vysvetlím jednotlivé partície. 

• partition C: - je systémový disk. Je na ňom uložený dashboard, nič iné sa naň ne-
ukladá.  

• partition E: -  slúži k ukladaniu pozíc hier a programov. Má veľkosť cca 5GB. 

• partition F: -    slúži k ukladaniu ľubovolných dát ako sú hry, filmy, hudba. Jeho 

kapacita sa odvíja od veľkosti disku a stanovuje ju jednoduchá rovnica: Celková 

kapacita disku – partition  

C,E,X,Y,Z = 8GB 

Fx = 120GB  

veľkosť F = Fx – C,E,X,Y,Z.   

Takže napr. pri 120GB disku bude veľkosť partition F cca. 112 GB.  

• partition X,Y,Z  - slúži na cachovanie hier hraných z DVD. Nikdy sa naň nič ne-

ukladá 

7. Dokončenie inštalácie 

Na to, aby sa nám nový dashboard spúšťal automaticky namiesto originálneho, bolo treba v 

už nabootovanom dashboarde nakopírovať na partíciu C súbory default.xbe a config.xml. 
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Ďalej nasledovalo premenovanie súboru default.xbe na xboxdash.xbe. Po týchto úpravách 

už XBOX po zapnutí naštartoval aj s novým dashboardom. 

8. FTP prepojenie 

Nový dashboard so zmeneným config.xml súborom funguje ako FTP server. Po pripojení 

druhého zariadenia (PC) sa automaticky aktivuje sieťová karta a XBOXu je pridelená IP 

adresa, ktorá je v tomto súbore zadefinovaná. Z PC sa dá jednoducho pomocou FTP clienta 

pripojiť na XBOX, zadaním ako cieľovej adresy, adresu XBOXu a užívateľské meno 

a heslo sa použije to, ktoré je v config.xml. Po pripojení je možné prehliadať jednotlivé par-

tície, vytvárať, vymazávať, kopírovať súbory. 

Kompletný config.xml viz. Prípoha PIII. 
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3.1.2.2 UnleashX - popis 

Je to jeden z najpoužívanejších dashboardov na XBOXe. Inštalácia bola už vysvetlená a 

teraz sa pokúsim o popis jednotlivých obrazoviek. 

Úvodná obrazovka je veľmi podobná s obrazovkou, ktorá je v originálnom MS Dashboar-

de. Samozrejme, je tu ale množstvo doplnkových funkcií, ktoré originál neobsahuje. Vopred 

sa ospravedlňujem za zníženú kvalitu niektorých obrázkov.  

Hlavná obrazovka obsahuje informácie o stave miesta na jednotlivých partíciách, stav teplo-

ty, IP adresu, počet pripojených užívateľov cez FTP, stav DVD mechaniky. Toto sú po-

stranné informácie, ktoré dávajú užívateľovi prehľad o stave XBOXu. V strede obrazovky 

je vlastne hlavné menu, ktoré obsahuje nasledovné položky: Lunch DVD, Games, Applica-

tions, System, File Explorer, MS Dashboard, Restart, Turn off. 

 

Obr. 38. UnleashX  Hlavná obrazovka. 

Pokiaľ je nastavené, že po vložení DVD sa aplikácia na disku nespustí, potom na tento účel 

slúži Lunch DVD. Je to vhodné napríklad pri kopírovaní DVD s hrou na HDD, aby sa skrá-

til čas načítavania pri hraní. 
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V položke Games sa nachádzajú všetky hry, ktoré boli skopírované na HDD. 

 

Obr. 39. UnleashX  Games. 

V Applications sa pre zmenu nachádzajú programy nahrané na HDD. Napríklad dvd2xbox 

slúži na nahrávanie DVD do XBOXu.  

File Explorer – súborový manager 

 

Obr. 40. UnleashX  File Explorer. 
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Je tu možná aj editáca textových alebo xml súborov. 

 

Obr. 41. UnleashX  Textový editor. 

Najdôležitejšia položka je položka Systems. Tá sa rozvetvuje na ďalšie voľby: Settings, 

Game Saves Manager, Misc, Format Menu, Skins. 

 

Obr. 42. UnleashX  Systems. 
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Settings obsahuje nastavenia všetkého, čo XBOX dokáže. 

 

Obr. 43. UnleashX  Settings. 

Autolaunch -  nastavenia, či sa majú DVD spúšťať automaticky po vložení, alebo až na po-

vel. 

 

Obr. 44. UnleashX  Autolaunch. 
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Date and Time – nastavenie dátumu a času. Tento čas je možné po pripojení XBOXu do 

internetu synchronizovať s SNTP serverom. 

 

Obr. 45. UnleashX  Date and Time. 

Gamepad/IR controler – nastavovanie ovládača 

Live Update – aktualizácia i internetu     

   

Obr. 46. UnleashX  Live Update. 
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Network – kompletné nastavenie siete, nastavenie FTP. 

 

Obr. 47. UnleashX  Network. 

Screen Calibration – nastavenie posuvu obrazu na TV 

 

Obr. 48. UnleashX  Screen Calibration. 
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Sound and Audio – nastavenie hlasitosti, prehrávanie zvuku, výber zvukov. 

 

Obr. 49. UnleashX  Sound and Audio. 

Storage -  informácie o HDD o jednotlivých partíciách 

 

Obr. 50. UnleashX  Storage. 
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System - informácie o teplote, verzií a tak ďalej 

 

Obr. 51. UnleashX  System. 

Video Display - nastavenie parametrov TV. 

 

Obr. 52. UnleashX  Video Display. 
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Game Save Manager - zoznam uložených  pozíc v hrách. 

 

Obr. 53. UnleashX  Game Save Manager. 

Misc - práca s FTP. 

 

Obr. 54. UnleashX  Misc. 
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Format menu - formátovanie jednotlivých partícií 

 

Obr. 55. UnleashX Format menu 

Skins - grafické variácie prostredia 

 

Obr. 56. UnleashX Skins. 
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3.1.3 XBMC 

XBOX je veľmi dobre vybavený pre prehrávanie najrôznejších multimediálnych  súborov 

a médií. A práve na tieto účely je určená aplikácia XBOX Media Center. Vďaka nej je 

XBOX schopný prehrávať všetko, od DVD filmov (aj bez diaľkového ovládača), cez filmy 

v najrôznejších formátoch (DivX, XviD, MPEGx...) a všetky možné audio súbory (MP3, 

WMA, OGG...), až po fotografie z digitálnych fotoaparátov. Ba dokonca je možné pripoje-

nie na internet a nasledovné poskytnutie informácii, či už aktuálne počasie, počúvanie rádia, 

sledovanie filmových ukážok, sledovanie internetovej televízie. Celá konfigurácia XBMC je 

riešená pomocou štyroch základných častí, a to xboxmediacenter.xml, keymap.xml, filezilla 

server.xml a konfiguračných súborov pre web server. Xboxmediacenter.xml je hlavný kon-

figuračný súbor pre XBMC. Keymap určuje mapovanie kláves na controller/remote control-

ler, filezilla je ftp server, kde sa dajú nastavovať účty a prístupové práva a konfiguračné 

súbory pre web sú konfiguračné súbory pre web.  

Najdôležitejšie obrazovky XBMC. Po naštartovaní programu sa zobrazí úvodná obrazovka, 

ktorá dáva na výber tieto možnosti: My Games, My Pictures, My Videos, My Music, Weat-

her, Settings, My Files, tlačítko označené šípkou nahor a tlačitko vypnutia.  

 

Obr. 57. XBMC úvodná obrazovka. 
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Voľba My Aplication ponúka možnosť výberu medzi jednotlivými aplikáciami na XBOXe. 

Položka Games ponúka hry, ktoré sú uložené na HDD. Ďalej je tu možnosť prepojenia via-

cerých XBOXov pomocou voľby Xlink Kai. Ďalšou z položiek je Aplication, kde sa nachá-

dzajú programy. Položka Consoles združuje emulačné programy. Aplikácie je možné rôzne 

zoraďovať a meniť ich zobrazenie tak ako sme na to zvyknutý z WINDOWS.  

 

Obr. 58. XBMC My Aplication 

Voľba My Pictures  je orientovaná na prehliadanie fotoalbumov. Tu je  možnosť usporiada-

nia jednotlivých fotografií a zmena ich zobrazenia. Ako sa u prehliadačov obrázkov patri, je 

možnosť spustenia SlideShow, teda postupného prehliadania obrázkov. 

 

Obr. 59. XBMC My Pictures. 
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Ďalšia na rade je voľba My Videos. Tú v mojom prípade využívam najviac. Slúži na prehrá-

vanie všemožných video formátov a v neposlednom rade aj DVD filmov, bez potreby zakú-

penia DVD kitu. Samozrejme, je tu podpora tituliek, ktoré však musia mať identický názov 

ako film. 

 

Obr. 60. XBMC My Videos_1. 

Aj tu je možné jednotlivé položky radiť podľa názvu alebo dátumu a meniť ich zobrazenia. 

Bohužiaľ sa mi nepodaril spustiť menu pri vložení akéhokoľvek DVD filmu a tak som ich 

spúšťal priamo z DVD z konkrétneho súboru. 

 

Obr. 61. XBMC My Videos_2.  
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Samotné zobrazenie filmu je veľmi rýchle. XBMC poskytuje množstvo funkcíí, ako naprí-

klad menenie pomeru obrazu, zobrazenie počtu snímkov za sekundu. Film je samozrejme 

možné pretáčať, zastavovať, ba dokonca je možné film ponechať spustený a vrátiť sa do 

menu. 

 

Obr. 62. XBMC film. 

Voľba s príznačným názvom My Music nemôže byť určená na nič iné ako na prehrávanie 

audioformátov. Tu je možné pripojenie na sieť a počúvanie rozličných rádií. Samozrejme, 

záleží na konfiguračnom súbore, odkiaľ používa zdroje. 

 

Obr. 63. XBMC My Music. 
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Pre ľudí, ktorí sú závislí od počasia, je tu položka Weather. Informácie o počasi 

v konkrétnom meste a v konkrétnej krajine sa do nej dostávajú zo stránky 

www.weather.com.  

 

Obr. 64. XBMC Weather. 

Na kompletné nastavenie XBMC slúži položka Configuration. Tu je dostupné kompletné 

nastavenie, aké si môže rozumný človek predstaviť. Každá položka zo základného menu tu 

má svoje podrobné nastavenia. Je možné nastaviť font tituliek pri prehrávaní videa, nastaviť 

ip adresu sieťového pripojenia, nastavovať Skiny  XBMC a mnoho ďaľšieho. 

 

Obr. 65. XBMC Configuration. 

http://www.weather.com
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Pre prácu s jednotlivými súbormi a adresármi poslúži položka My Files. Je to vlastne com-

mander, v ktorom sa dajú prevádzať operácie, ako napríklad kopírovanie, mazanie, vytvára-

nie súborov. 

 

Obr. 66. XBMC My Files. 

Šípka v pravej spodnej časti predstavuje rôzne nadstavby. Je možné prehliadať online ukáž-

ky filmov, alebo sledovať internet TV. 

 

Obr. 67. XBMC nadstanvy. 
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Úplne napravo sa nachádza tlačítko power. Je určené na reštartovanie XBOXu alebo na 

jeho vypnutie alebo iba na ukončenie samotného XBMC.  

 

Obr. 68. XBMC Power. 

3.1.4 XBOX Linux 

3.1.4.1 X-DSL Linux 

Táto skratka neznamená vysokorýchlostné pripojenie na internet, ale Damn Small Linux. X-

DSL je všestranná linuxová distribúcia, ktorá má len 50MB. Tento produkt je navrhnutý 

tak, aby sa dokázalo z 50 MB dosiahnuť čo najviac. Všetky obsiahnuté aplikácie sú vybera-

né vzhľadom na ich veľkosť a rýchlosť. Popíšem jednotlivé aplikácie.[12] 

XMMS je to obdoba winampu, ktorý je známy z windows. Presne ako winamp aj XMMS je 

určený na prehrávanie audioformátov. FTP client - pre pripojenie cez FTP na vzdialený ser-

ver. Na prehliadanie internetového obsahu sú určené nasledovné aplikácie (links web brow-

ser, FireFox, Dillo web browser). Sylpheed email je na prehliadanie emailov. Na písanie 

dokumentov slúži Flwriter. Xpaint, and xzgv úprava grafiky. Xpdf prehliadanie pdf formá-

tov. EmelFM súborový manager. Naim program na komunikáciu cez internet a mnohé ďal-

šie. Prostredie, v ktorom je celý linux sa nazýva Fluxbox . [12] 
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Live cd XDSL: 

1. Napálenie linuxu 

Image súbor linuxu je k dispozícií z dostupného servera najlepšie 

http://www.damnsmalllinux.org/download.html . Na vypálenie treba použiť príslušný vypa-

lovací software, ja osobne doporučujem NERO. Dôležitý je aj výber DVD disku. Nie každý 

XBOX prečíta každé médium. Doporučujem DVD VERBATIM. 

2. Spustenie 

Po vložení DVD do mechaniky linux začne bootovať. Pokiaľ sa tak nestane, treba XBOX 

reštartovať. Automaticky začne nabiehať LINUX. Na ovládanie sa používa klasický ovlá-

dač, ale je možné použiť aj adaptér na pripojenie klávesnice a myši. 

3. Prihlásenie 

Štandartné prihlásenie je nastavené takto: 

user:dsl password:dsl 

user:root password:xbox  

 

Inštalácia XDSL: 

Pokiaľ Live CD funguje správne, je možné XDSL nainštalovať priamo na HDD. Sú 3 druhy 

inštalácie. 

Frugal install – Súbory XDSL sú skopírované do E:\KNOPPIX\KNOPPIX . To zaberie na 

disku asi 50 MB. Bohužial, táto inštalácia sa správa presne ako Live CD teda (Read-only). 

Loopback install – XDSL sa nainštaluje do E:\xdslfs, alebo F:\xdslfs. Miesto na disku je 

možné zvoliť od 200MB do 2GB. 

Native install – XDSL sa nainštaluje na prídavnú F partíciu a teda je potrebná mať HDD 

väčší ako 8 GB. 

Pre zvolenie jednej z týchto troch inštalácií je treba priamo v linuxe otvoriť menu->Apps-

>Tools -> appropriate option  

 

http://www.damnsmalllinux.org/download.html
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Rozšírenie XDSL 

Pokiaľ je XDSL spustené ako Live CD alebo Frugal, je možné spúšťať prídavné programy 

použitím rozšírenia. XDSL je plne kompatibilný s rozšíreniami, ktoré poskytuje Damn Small 

Linux. Rozlíšenia sú dostupné na stránke 

http://distro.ibiblio.org/pub/linux/distributions/damnsmall/mydsl/ alebo priamo na ploche je 

ikona myDSL.  

Ukladanie nastavenia 

Ak je nainštalovaný XDSL pomocou FRUGAL, nie je možné ukladanie nastavenia. Dá sa to 

však obísť separovaným zápisom do backup.tar.gz. Voľba desktop menu ->System -

>Backup/Restore a nastavenie hda50 backup. Toto nastavenie sa uloží po reštarte. Pre na-

stavenie, ktoré súbory sa majú ukladať, treba editovať edit /home/dsl/.filetool.lst. Toto nie 

je potrebné, ak je Loopback alebo Native inštalácia.  

Na písanie je možné používať virtuálnu klávesnicu. Na obrázkoch je zobrazený XDSL linux 

v prostredí Fluxbox. 

 

Obr. 69. XDSL desktop. 

http://distro.ibiblio.org/pub/linux/distributions/damnsmall/mydsl/
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Obr. 70. XDSL firefox. 

XBOX podporuje aj klasickú klávesnicu a myš. Na ich zapojenie je potrebné dokúpiť zaria-

denie napr.: USB adapter. Pripája sa namiesto klasického ovládača. V tomto prípade bolo 

testované zariadenie Magic XFPS. Bohužial toto zariadenie funguje iba na FPS hry. Tento 

adaptér má totiž dopredu nadefinované klávesy, ktoré nahrádzajú klasický ovládač. Takže 

písanie príkazov v linuxe, nie je možné s použitím týchto adaptérov. Ich uplatnenie je pria-

mo v hrách.  

Tab. 4. Pripojenie klávesnice a myši na XBOX 

 

Obr. 71. SmartJoy Frag 

 

Obr. 72. Magic XFP 

 

Obr. 73. USB adapter 
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3.1.4.2 Gentoox Linux 

Je to ďalšia verzia linuxu, ktorý funguje na XBOXe. Táto distribúcia je ale veľmi obsiahla a 

zaberie celý HDD. 

Verzie: 

• Home - Verzia pre začiatočníka, obsahuje veľa programov.  

• Pro - Verzia pre užívateľov, ktorý si chcú nahrať iba potrebné aplikácie.  

• Sparkle - Obnovenie súborového systému.  

• MCE - Gentoox Media Center Edition.  

• Resctoox -  Obnova Gentoox Linuxu. 

  
Súčastné dostupné verzie: 

• Home - 4.0   

• Pro - 2.0a  

• Resctoox - 1.8 

• MCE - 1.2  

• Sparkle - 1.5  

 

Inštalácia Gentoox: 

Doporučujem stiahnuť najnovšiu verziu. Jednotlivé verzia sú dostupné na domovských 

stránkach http://gentoox.shallax.com. Na vypálenie DVD doporučujem použiť NERO. Naj-

lepšie je použitie čo najnižšej rýchlosti a DVD nechať uzavrieť.  

Po vložení DVD nabehne inštalácia gentoox. Zisťuje nastavenie IP adresy, ak nenájde 

DHCP, tak automaticky pridelí. 

IP: 192.168.1.13 

Netmask: 255.255.255.0 

Gateway: 192.168.1.1  

 

 

http://gentoox.shallax.com
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Prihlasovanie do gentoox: 

Username: root 

Password: xbox 

Username: gentoox 

Password: xbox  

 

V ponuke sú 3 typy inštalácie E, F, Native. 

E - tradičná inštalácia, kedy sa všetko ukladá na partíciu E. Je treba 4,5GB na E 

F- ukladá „rootfs“ a „swap“ na partíciu F a ostatné necháva na partící E. Je treba 4,5 GB F 

a 650 MB na E 

native - kompletne preformátuje partíciu F a nahrá tam rootfs. Je treba 4,5GB na E a 2GB 

na F 

Gentoox je možné spúšťať automaticky po štarte. Tu ale treba zásah do biosu. Táto mož-

nosť sa mi nepozdáva ako šťastné riešenie, preto odporúčam druhý spôsob a to je spúšťanie 

priamo z XBOXu pomocou súboru gentoox.xbe. Pri prvom spúšťaní sa nastavuje rozlíšenie. 

Samozrejme, aj tu je podpora HDTV. 

Ďalej treba vybrať grafické prostredie (kde, xfce). Prostredia sa dajú meniť aj priamo 

v linuxe. 

Pokiaľ si praje užívateľ zmenu hesla, postup je nasledovný: 

su - 

[vložiť root password ak sa spýta] 

passwd menu užívateľa 

nové heslo 

nové heslo ešte raz 

Na komunikáciu slúži takisto ako u predošlej verzie virtuálna klávesnica, ktorú je možné 

nahradiť klasickou klávesnicou, pripojenou pomocou adaptéra. Bohužiaľ, tento linux mi 

nejako nesadol. Nešlo nastaviť inú IP adresu, ale to by sa nejako dalo spraviť, ale zásadná 

vec je, že pri odhlásení sa pokazila grafika a linux sa stal neovládateľným. Ďalšia vec, neda-

lo sa prepnúť z jedného prostredia do druhého. Bohužiaľ, nezistil som príčinu a tak som ani 
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neriešil tú IP adresu. Na druhú stranu sa tento linux veľmi príjemne ovláda aj bez klávesni-

ce. Dokonca som na ňom rozbehol aj DVD film. 

 

Obr. 74. Gentoox aplikácie. 

 

Obr. 75. Gentoox klávesnica. 
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3.2 Porovnanie 

Rozbor nákladov na kúpu XBOXu a PC. 

XBOX plus komponenty: 

Tab. 5. Náklady 

Produkt cena Kč cena Sk zdroj 

XBOX 4399 5807 http://www.gamestation.cz/xbox/ 

Modchip Aladdin Advance 451 595 http://www.hrajte.sk/index.php?vid=972 

Xbox USB adaptér x 2 460 607 http://www.gamesparadise.cz/index.php?vid=981 

Klávesnica 115 152 http://eshop.comtec.sk 

Myš 97 128 http://eshop.comtec.sk 

 5522 7289  

 

Do nákladov nebol započítaný materiál a náradie na inštaláciu modchipu a TV. Bolo počíta-

né s tým, že tieto veci má každý, alebo si dokáže požičať. 

Bohužiaľ, paradoxom zostáva fakt, že samotná úprava ni eje možná bez použitia PC, ktorý 

potrebujeme na upravovanie konfiguračných súborov, ale hlavne na vypaľovanie potrebné-

ho softwaru. 

Ceny PC zostavy sa pohybujú od 11000 Kč smerom hore. Záleží na každom, aké PC si vy-

berie. Pokiaľ je požadovaný od PC herný výkon, ktorý sa dá porovnávať s XBOXom je 

nutné investovať značné finančné prostriedky. PC nám k tomu predraží aj monitor, ktorý je 

potrebný. 

Finančne teda vychádza jednoznačne lepšie XBOX. 

Pre a proti 

Ovládanie: lepší XBOX 

Veľmi jednoduché a intuitívne. Pomocou jedného ovládača. Žiadne náročné inštalácie hier. 

Jednoducho otvoriť DVD ROM vložiť DVD a hrať.  

 

http://www.gamestation.cz/xbox/
http://www.hrajte.sk/index.php?vid=972
http://www.gamesparadise.cz/index.php?vid=981
http://eshop.comtec.sk
http://eshop.comtec.sk
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Systém: lepší XBOX 

Prehľadné menu, veľmi rýchle, pekne upravené. Štart samotnej konzoly je rýchly. 

Hry: lepší XBOX 

Hry sú jednoznačne rýchlejšie a krajšie. Nevýhoda je ovládanie cez ovládač pri prechode 

z PC. Samozrejme je tu možnosť pripojenia klávesnice a myši. 

Multimédia: lepšie PC 

Pre klasické prehliadanie filmov, pesničiek, a obrázkov postačuje aj XBMC. Bohužiaľ pre 

lepšiu prácu s videami alebo obrázkami treba PC. 

Linux: lapšie PC 

Tu jednoznačne vedie PC. Linux síce ide spustiť na XBOXe, ale ako náhrada za PC nepo-

stačuje. XBOX má v tomto smere slabý výkon. Ovládanie bez klávesnice a myši je dosť 

náročné. Doba načítania jednotlivých aplikácií je vďaka malej pamäti veľmi dlhá. Ako malá 

kompenzácia za PC je to dostatočné, ale ako plnohodnotnú náhradu to nedoporučujem. 
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ZÁVER 

V tejto práci nebol pokus o dokázanie, že je XBOX lepší, ako klasické domáce PC. Išlo 

o overenie tvrdení, že je možné PC nahradiť XBOXom v každom smere. XBOX je kon-

štrukčne úplne totožný s PC. Obsahuje komponenty, ako sú matičná doska, procesor, HDD, 

DVD ROM, grafický chip, pamäte, USB rozhrania, ethernetové rozhranie, grafický výstup. 

Na overenie predchádzajúcich tvrdení bolo treba dokázať, že nielen konštrukčne, ale aj 

funkčne sa XBOX približuje klasickému PC. Samozrejme, XBOX ako taký, nie je možné 

porovnávať s PC, pokiaľ neprejde patričnou úpravou. V tomto prípade bol do XBOXu in-

štalovaný ModChip Aladdin Advanced, ktorý nahradil originálny BIOS. Ďalšie úpravy sa 

týkajú už len softwarovej časti. Testované boli nasledovné parametre: 

Grafika: plynulosť a grafické spracovanie hier, ktoré sú dostupné aj na PC aj na XBOXe. 

Hry na XBOXe sú plynulé a graficky prepracované. Na porovnateľný zážitok z hrania hry 

na PC by bolo potrebné vlastniť výkonnú PC zostavu. 

Ovládateľnosť: jednoduchosť ovládania sa XBOXU nedá uprieť. Celý systém sa dá veľmi 

jednoducho ovládať jedným ovládačom. 

Systém: bol nainštalovaný iný operačný systém (UnleashX). Ten ponúka širšie využitie 

XBOXu. Vtomto prípade bolo možné sa na XBOX pripájať ako na FTP server, pracovať 

s dátami uloženými na HDD, kompletne nastavovať konfiguráciu XBOXu. 

Multimédiá: pre prácu s multimédiami bolo potrebné nainštalovať program XBMC( Xbox 

Media Center). Ten síce umožnil prezeranie videí, DVD filmov, hudobných formátov, ob-

rázkov, ale neumožňoval ich editáciu, kde značne zaostával za PC 

OS Linux: pre maximálne možné porovnanie bol na XBOX nainštalovaný OS Linux. Tento 

operačný systém je možné prevádzkovať aj na PC aj na XBOXe, preto poslúžil pre porov-

nanie najadekvátnejšie. Porovnával som rýchlosť systému, možnosti, ovládanie. Tu musím 

uznať, že Linux na XBOXe síce funguje, ale bohužiaľ vo výkone veľmi zaostáva za PC. 

Ovládanie je vďaka ovládaču veľmi náročné. Linux na XBOX teda nedokáže poskytnúť 

úplnú náhradu za klasické PC, ale základné funkcie sa tam zvládnuť dajú.  

Hracia konzola XBOX, ktorá bola pôvodne určená len na hranie hier, sa v tomto prípade 

zmenila na multimediálne centrum. Dokáže prehrávať DVD, audio a video formáty, je mož-

né na ňom hrať najnovšie hry a práve na toto je vhodné XBOX použiť. Tvrdenie, že XBOX 
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je plnohodnotná náhrada za PC je veľmi odvážne. XBOX síce dokáže nahradiť PC, ale len 

vo veľmi krajnom prípade. Faktom však aj naďalej zostáva cena, za ktorú sa dá zakúpiť. 

A tu nemá PC žiadnu šancu. Za necelých 7300 Sk nie je možné zohnať tak výkonný PC, 

ktorý by bez problémov zvládal najnovšie hry. Osobne teda doporučujem XBOX na hranie 

hier a prehliadanie multimédií, kde kompletne nahradzuje PC. 
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X2.2L,X2.3L, X2.3bL, 
X2.6L, X2.6CE L:

ano

ano

v1:
nie

v2 blue/white,
v2 GS blue/white:

ano

ano ano ano ano ano

Xbox v1.6b

X2.0L, X2.1L:
nie

X2.2L,X2.3L, X2.3bL, 
X2.6L, X2.6CE L:

ano

ano

v1:
nie

v2 blue/white,
v2 GS blue/white:

ano

ano ano ano ano ano
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X-elixis
Basic/Pro/Plus

X-tasis
Basic/Pro/Plus

PC-BioXX
OpenXbox
NitroXX

Xecuter Pro
2.0/2.1/2.2/2.3b

Xecuter Lite Plus
2.0/2.2/2.3/2.3b

X-B.I.T
v1.0/v1.5

Chameleon
v1.0/1.3/1.5/1.8

AppleX
Pro/V/VI

VI Pro/ VII

Obrázok

Výrobca Gr-Mods n/a Team Xecuter Team Xecuter Team DMS Team Xodus Apple Chips
Cena 30EUR $69 $40 $52 $28 $29 $30

Dostupnosť
verzií

dostupné nedostupné nahradil
SmartXX

nedostupné nahradil
Xecuter3

nedostupné nahradil
Xecuter Lite + Xapte nedostupné nedostupné nahradil

Xenium

Pro/V/VI/VI Pro:
nedostupné

VII:
dostupné

Veľkosť 
pamäte

256KB 1MB 1MB 1MB 2MB 1MB

V:
256KB

Pro/VI/VI Pro/VII:
1MB

Verzia
biosu

záleží od predajcu n/a

X2.0P old:
nie

X2.0P new a X2.1P:
cromwell 1.8

X2.2P:
Cromwell Flashbios 

1.8
X2.3bP:

Cromwell Flashbios 
2.27

X2.0L+:
cromwell 1.8

X2.2L+:
Cromwell Flashbios 1.8

X2.3L+, X2.3bL+:
Cromwell Flashbios 2.27

n/a

v1.0 and v1.3:
Cromwell Flashbios 

1.8
v1.5 and v1.8:

Cromwell Flashbios 
2.27

V/Pro/VI:
X2 bios

VI Pro/V II:
bank0: X2 bios

bank1: EvoX M8_v16

MultiBios

pomocou 
X-Programmer 

Plug-In
2 x 256 ,

1 x 256 + 1 x LPC 
modchip

PC-BioXX & OpenXbox:
je možnosť
NitroXX:

ano
4x256
2x512
1x1024

ano
4x256,
2x512,
1x1024,

2x256 1x512

ano
2x512,
1x1024

1x2048k,
2x1024k,

2x512k 1x1024k, 
2x256k 1x512k 

1x1024k,
4x256k 1x1024,
4x256k 2x512k

ano
4x256,
2x512,

2x512stealth,
1x1024,

1x256 1x512

Pro/V:
nie

VI/VI Pro/VII:
ano

2x512
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Upgrade Xbox software LPT LPT, Xbox software LPT, Xbox software USB LPT, Xbox software  V/VI/VI Pro/VII:
Xbox software

Socked
X-tasis Pro, X-elixis 

Pro, X-tasis Plus:
ano

nie nie nie nie nie nie

Xbox v1.0 ano ano ano ano ano ano ano
Xbox v1.1 ano ano ano ano ano ano ano

Xbox v1.2 ano ano

X2.0L+:
nie

X2.2L+, X2.3L+, 
X2.3bL+:

ano

ano ano ano ano

Xbox v1.3

X-elixis Basic, X-elixis 
Pro:
nie

X-tasis Basic, X-tasis 
Pro, X-tasis Plus, X-

elixis Plus:
ano

nie

X2.0P, X2.1P:
nie

X2.2P, X2.3bP:
ano

X2.0L+:
nie

X2.2L+, X2.3L+, X2.3bL+:
ano

ano

cham v1.0:
nie

cham v1.3, v1.5, 
v1.8:
ano

ano

Xbox v1.4

X-elixis Basic, X-elixis 
Pro:
nie

X-tasis Basic, X-tasis 
Pro, X-tasis Plus, X-

elixis Plus:
ano

nie

X2.0P, X2.1P:
nie

X2.2P, X2.3bP:
ano

X2.0L+:
nie

X2.2L+,X2.3L+, X2.3bL+:
ano

ano

cham v1.0:
nie

cham v1.3,v1.5, v1.8:
ano

Pro:
nie

V/VI/VI Pro/ VII:
ano

Xbox v1.5

X-elixis Basic, X-elixis 
Pro:
nie

X-tasis Basic, X-tasis 
Pro, X-tasis Plus, X-

elixis Plus:
ano

nie

X2.0P, X2.1P:
nie

X2.2P, X2.3bP:
ano

X2.0L+:
nie

X2.2L+,X2.3L+, X2.3bL+:
ano

ano

cham v1.0:
nie

cham v1.3,v1.5, v1.8:
ano

Pro:
nie

V/VI/VI Pro/VII:
ano

Xbox v1.6

X-elixis Basic, X-elixis 
Pro, X-tasis Basic, X-

tasis Pro, X-elixis Plus:
nie

X-tasis Plus:
ano

nie

X2.0P, X2.1P:
nie

X2.2P, X2.3bP:
ano

X2.0L+
X2.2L+
X2.3L+

X2.3bL+:
nie

ano

cham v1.0:
nie

cham v1.3,v1.5, v1.8:
ano

Pro/V/VI:
nie

VI Pro/VII:
ano

Xbox v1.6b

X-elixis Basic, X-elixis 
Pro, X-tasis Basic, X-

tasis Pro, X-elixis Plus:
nie

X-tasis Plus:
ano

nie

X2.0P, X2.1P:
nie

X2.2P, X2.3bP:
ano

X2.0L+
X2.2L+
X2.3L+

X2.3bL+:
nie

ano

cham v1.0:
nie

cham v1.3,v1.5, v1.8:
ano

Pro/V/VI:
nie

VI Pro/VII:
ano
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Sony PlayStation 2 Nintendo GameCube Microsoft Xbox Microsoft Xbox360 

Procesor 

128-bit "Emotion Engine" 
300 MHz 

(FPU) co-processor pre 
pohyblivú desatinnú čiarku 

Maximálna priepustnosť 
zbernice 3.2 GB za sekundu 

"Gekko" IBM Power PC microprocessor 
485 MHz 
Cache: 

 - level 1: 32 KB Inštrukcie a 32 KB dáta 
 - level 2: 256 KB  

32-bit adresná, 64-bit dáta zbernica 
Maximálna priepustnosť zbernice 2.6 GB 

za sekundu 

Modifikovaný  Intel 
Pentium III 
733 MHz 

Maximálna priepustnosť 
zbernice 6.4 GB za 

sekundu 

3 jadrový IBM Power-PC 
každé jadro na 3,2 GHz 

Grafika 

"Graphics Synthesizer" 
150 MHz 

cache 4 MB VRAM 
75 miliónov polygónov za 

sekundu  

"Flipper" ATI grafický chip 
162 MHz 

1 MB texture cache 
3 MB Mosys 1T-SRAM  

12 miliónov polygónov za sekundu  

nVidia 3-D grafický chip 
250 MHz 

125 miliónov polygónov za 
sekundu  

ATI Xenos 
500 MHz 

48 paralelných jednotiek 
500 miliónov polygónov 

za sekundu 

Audio 
SPU2 (+CPU), 48 kanálov, 

44.1- alebo 48-kHz frekvencia, 
2 MB pamäť 

16-bit digital signal processor, 
64 kanálov, 48-kHz frekvencia 

3-D audio  
processor  

Dolby Digital 5.1 

3D audio 
Dolby Digital 5.1 

RAM 32 MB  40 MB 64 MB  512 MB, GDD3 

Médium 4.7-GB DVD  
originál PlayStation CD 1.5-GB disk 4.7-GB DVD 4.7-GB DVD dual-layer 

Ovládanie 2 porty pre ovládače 4 porty pre ovládače 4 porty pre ovládače Wireless ovládače (4x) 
HDD nie nie 8GB 20GB 
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Sieť zvlášť adaptér nie áno áno 
 



 

 

PRÍLOHA P III: KOMPLETNÝ CONFIG.XML (A)  

  - <UnleashX> 

- <Settings> 

  <MSDashBoard>C:\Xboxdash.xbe</MSDashBoard>  

  <Password MaxTries="3" />  

- <!--  

 Network Enable="Yes/No" Type="Static/DHCP"   -->  
- <!--  

 Default Enable="Yes" Type="static"  
   IP = 192.168.0.100 
   Subnet = 255.255.255.0 

  -->  

- <Network Enable="Yes" Type="DHCP"> 

  <IP>192.168.0.100</IP>  

  <Subnet>255.255.255.0</Subnet>  

  <Gateway>192.168.0.1</Gateway>  

  <DNS1>192.168.0.1</DNS1>  

  <DNS2>192.168.0.7</DNS2>  

  </Network> 

- <!--  FTP Enable="Yes/No"   -->  

- <!--  Default Enable="Yes" 

   User  = xbox 
   Password = xbox 
   Port  = 21 
   MaxUsers = 2 
   AllowAnon = No   

  -->  

- <FTP Enable="Yes"> 

  <User>xbox</User>  

  <Password>xbox</Password>  

  <Port>21</Port>  

  <MaxUsers>2</MaxUsers>  

  <AllowAnon>No</AllowAnon>  

  <Greeting>Welcome to XBOX FTP Server</Greeting>  

  </FTP> 

- <Newsfeed Enable="False" Interval="30"> 

  <URL>www.xbox-scene.com/xbox1data/xbox-scene.xml</URL>  

<URL>www.xbins.org/xbins.xml</URL>  

  </Newsfeed> 

- <!--  User Preference   -->  

- <Preference> 

http://www.xbox-scene.com/xbox1data/xbox-scene.xml
http://www.xbins.org/xbins.xml


 

 

PRÍLOHA P III: KOMPLETNÝ CONFIG.XML (B)  
  <Games AutoLaunch="Yes" />  

  <DVD AutoLaunch="Yes">F:\Apps\DVDX2\default.xbe</DVD>  

  <AudioCD AutoLaunch="Yes">C:\xboxdash.xbe</AudioCD>  

  <Data AutoLaunch="Yes" />  

- <!--  Volume: 0-100  -->  

  <SNTP Synchronize="No">216.244.192.3</SNTP>  

- <!--  Speed: 1-5 and anything in between, i.e. 1.5   -->  

  <FanSpeed>1</FanSpeed>  

- <ScreenSaver Wait="60"> 

  <Text>UnleashX V0.39</Text>  

  </ScreenSaver> 

  <AutoTurnOff>0</AutoTurnOff>  

  <EnableDriveF>True</EnableDriveF>  

  <EnableDriveG>False</EnableDriveG>  

  </Preference> 

  </Settings> 

- <Menu> 

  <Item Action="LaunchDVD">Launch DVD</Item>  

- <List Text="Games" Sort="On" Auto="On"> 

  <Path>E:\Games</Path>  

  <Path>F:\Games</Path>  

  <Path>G:\Games</Path>  

  <Path>E:\HDDLoader</Path>  

  <Path>F:\HDDLoader</Path>  

  </List> 

- <List Text="Applications" Sort="On" Auto="On"> 

<Path>E:\Apps</Path>  

  <Path>F:\Apps</Path>  

  <Item Action="TextEditor">Text Editor</Item>  

  </List> 

- <List Text="System" Sort="Off" Auto="On"> 

  <Item Action="Settings">Settings</Item>  

  <Item Action="SavesManager">Game Saves Manager</Item>  

- <List Text="Misc" Sort="Off" Auto="On"> 

  <Item Action="FTPStop">Stop FTP</Item>  

  <Item Action="FTPStart">Start FTP</Item>  

 <Item Action="FTPReset">Reset FTP</Item>  



 

 

PRÍLOHA P III: KOMPLETNÝ CONFIG.XML (C)   
  <Item Action="NETReset">Restart Network</Item>  

  <Item Action="TrayClose">Close DVD Tray</Item>  

  <Item Action="TrayOpen">Open DVD Tray</Item>  

  <Item Action="CopyDVD">Copy Game Disc</Item>  

  </List> 

- <List Text="Format Menu" Sort="Off" Auto="On" Password="Xbox"> 

  <Item Action="Format" Arg1="X">Format X Drive</Item>  

  <Item Action="Format" Arg1="Y">Format Y Drive</Item>  

  <Item Action="Format" Arg1="Z">Format Z Drive</Item>  

- <List Text="Format F Drive" Sort="Off" Batch="True"> 

  <Item Action="AskUser" Arg1="Format">Are you sure you want to 
format Drive F?</Item>  

  <Item Action="MessageBox" Arg1="Format">Press OK to proceed 
with the format operation.</Item>  

  <Item Action="Format" Arg1="F">Format F Drive</Item>  

  </List> 

- <List Text="Format G Drive" Sort="Off" Batch="True"> 

  <Item Action="AskUser" Arg1="Format">Are you sure you want to 
format Drive G?</Item>  

  <Item Action="MessageBox" Arg1="Format">Press OK to proceed 
with the format operation.</Item>  

  <Item Action="Format" Arg1="G">Format G Drive</Item>  

  </List> 

- <List Text="Format E Drive" Sort="Off" Batch="True"> 

  <Item Action="AskUser" Arg1="Format">Are you sure you want to 
format Drive E?</Item>  

  <Item Action="MessageBox" Arg1="Format">Press OK to proceed 
with the format operation.</Item>  

  <Item Action="Format" Arg1="E">Format E Drive</Item>  

  </List> 

  </List> 

  <Item Action="Skins">Skins</Item>  

  </List> 

  <Item Action="FileManager">File Explorer</Item>  

  <Item Action="C:\xboxdash.xbe">MS Dashboard</Item>  

  <Item Action="Restart">Reboot</Item>  

  <Item Action="Shutdown">Shutdown</Item>  

  </Menu> 

  </UnleashX> 


